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Introduction to EFT Server 

GlobalSCAPE's Enhanced File Transfer (EFT) Server is a managed file transfer (MFT) solution that 
provides secure data transactions over standard Internet protocols to secure and guarantee information 
transferred between business partners, clients, and branch offices. EFT Server provides organizations 
with a powerful and cost-effective alternative to leased lines, VANs, VPNs, and homegrown solutions. 
EFT Server is a modular solution, providing a low cost of entry to small- to medium-sized companies with 
security and compliance requirements, and a migration path for enterprise-level companies to expand 
their functionality as their business needs grow. 

Scroll down to view summaries of EFT Server's features. 

 

Secure File Transfers - Data is protected and controlled during transit and storage, and is fully 
auditable during that process. Once received, the data can be managed by an extensible, automated 
workflow framework based on specific triggered events. 

 Protection of intellectual property, trade secrets, and customer files transferred over the Internet 
using secure protocols including FTPS (SSL/TLS), SFTP (SSH2), HTTPS, and AS2.  

 Compliance with regulatory and privacy requirements such as PCI DSS, HIPAA, GLBA, and 
SB1386, by including OpenPGP technology for encrypting, decrypting, and signing files stored on 
disk.  

 Reliable, secure off-loading of files to another server or network share using standard FTP or 
HTTP clients, including Web browsers or secure FTP clients such as CuteFTP Professional. 

 Flexible authentication choices: AD/NTLM, ODBC, LDAP, and GlobalSCAPE Authentication  

 OpenPGP-based and transparent streaming encryption  

http://www.globalscape.com/cuteftppro/
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 Enforcement of strong passwords for user authentication. EFT Server supports password, public-
key, or one-time-password authentication. User profiles can be managed internally or externally 
through NTLM, Active Directory (AD), LDAP, or ODBC data sources. 

 Multi-part (segmented) transfers for faster delivery of large files over large geographical 
distances. Multi-part transfers require the use of compatible clients such as CuteFTP 
Professional. 

Auditability - Track and report on transactions throughout their life cycle. Secure data delivery requires 
strong audit trails for tracking and non-repudiation. EFT Server provides industry-standard logging (W3C, 
NCSA, Microsoft IIS Extended), e-mail notification of completed transactions, and digital certificates for 
proof of identity. 

 Non repudiation through granular transaction auditing and reporting  

 Guaranteed delivery (automatic and manual resume). EFT Server extends the industry standard 
FTP and HTTP protocols with enterprise-class reliability features, including post-transmission 
integrity verification, mid-file recovery, and automatic restart. 

 Data integrity validation  

Automatic, Schedulable File Maintenance - Automatically perform predefined actions when specific 

events occur to place files into the company workflow. 

 Create powerful event-based triggers with a simple point-and-click interface  

 Monitor folders for files added or modified  

 Run scripts or batch files on a schedule  

 Send e-mail notifications  

 Remove data that is past specified age limits  

 Offload and retrieve data to/from remote inboxes  

Simple Deployment - Easy to set up and manage secure transactions. 

 Complete programmatic interface. EFT Server can be controlled through EFT Administrator or 
through its Component Object Model (COM) interface. The COM API is a programmatic interface 
that allows you to control EFT Server from your own custom applications using any COM-enabled 
programming language.  

 Multiple administrators can connect and manage the server  

 Install, configure, and deploy in minutes into your existing architecture  

 Software-only solution; no hardware to install, no extra software to install on client computers  

 Professional Services can provide customization for your environment  

 Account Management. EFT Server allows you to quickly and efficiently manage the removal of 
users, manage temporary accounts, and address the revocation and, if necessary, re-issuance of 
expired or compromised public-keys or certificates. Manage system resources including 
bandwidth, folder access, file types, and more using granular or Site-wide controls provided for 
user and group management. Visually manage folder permissions via a Windows Explorer-like 
Virtual File System view. Inherit or override permissions, grant administrative, guest, or 
anonymous permissions, or deny access altogether. 

http://www.globalscape.com/cuteftppro/
http://www.globalscape.com/cuteftppro/
http://www.globalscape.com/cuteftppro/
http://www.globalscape.com/support/professional_services.aspx
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Expanded EFT Server Security 

The following modules can be added to EFT Server: 

AS2 Module - EFT Server's AS2 (Applicability Statement 2) module is used to exchange structured 
business data securely using the HTTP or HTTP/S protocol. Any type of data can be exchanged using 
AS2, including traditional EDI messages, XML, flat files, spreadsheets, and CAD/CAM data. 

HS-PCI Module - EFT Server facilitates compliance with the PCI DSS 1.1 specification for new and 
existing EFT Server customers that have a business mandate to achieve and maintain PCI DSS 
compliance.  

Auditing and Reporting Module (ARM) - The Auditing and Reporting Module (ARM) captures the 
transactions passing through EFT Server and provides an interface in EFT Administrator where you can 
use preconfigured reports or create your own custom reports to query, filter, and view transaction data. 
Data is stored in a fully relational database and can be analyzed in real time. 

DMZ Gateway Server - This optional server is designed to reside in the demilitarized zone to provide 
secured communications with EFT Server behind intranet firewalls without requiring any inbound firewall 
holes between the internal network and the DMZ. 

Secure Ad Hoc Transfer Module - EFT Server's Secure Ad Hoc Transfer (SAT) module allows your 
internal users to send and receive large e-mail file attachments to recipients outside of your organization 
quickly, reliably, and securely, all without having to manually create or maintain FTP accounts on EFT 
Server. 

Web Transfer Client - This optional Web Transfer Client is a browser-based file transfer client that allows 
users to upload and download files to an EFT Server using a connected Web browser. It gives your users 
a transparent way to connect, and you do not have to install anything on the client end; the Web Transfer 
Client deploys automatically from EFT Server.  

Support 

GlobalSCAPE's support pages provide information about software registration, user guides, downloads, a 
Knowledge Base, and how to contact us to get e-mail or telephone support. Refer to Getting Help for 
more information. 

What's New in EFT Server 5.2? 

EFT Server version 5.2 can be configured to use AS2 (Applicability Statement 2) to exchange structured 
business data securely using the HTTP or HTTP/S protocol. Any type of data can be exchanged using 
AS2, including traditional EDI messages, XML, flat files, spreadsheets, and CAD/CAM data. 

For details of EFT Server's AS2 module, refer to The AS2 Module. 

For what's new in any version of EFT Server, refer to the release notes stored in the installation folder as 
notes.txt, or online at http://www.globalscape.com/eft/history.aspx.  

 

http://www.globlascape.com/support
http://www.globalscape.com/eft/history.aspx
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Getting Started with EFT Server  

We have made every attempt to organize the table of contents in the order in which you will need to refer 
to the topics as you install and configure EFT Server and its add-on modules. Usually, the administrator 
will install and configure EFT Server before ever seeing the help file; however, because this help file is 
available online on the EFT Server support pages, http://www.globalscape.com/support/eft.aspx, we have 
also provided the installation instructions within the help file in the application.  

To become familiar with EFT Server and its add-on modules, read each of the topics in this user guide. 
Then follow the procedures in Installing and Activating the Software or, if you have already installed the 
software, follow the procedures in Configuring EFT Server and Your First Connection to EFT Server. 

This user guide provides the following information: 

 Installing and Activating the Software. This section includes information regarding installing EFT 
Server with Microsoft Clustering Services and Microsoft IIS, setting Windows system services, 
registry settings, and release notes. 

 Configuring EFT Server. This section helps you make Your First Connection to EFT Server, and 
provides information regarding the EFT Server Interface, EFT Server Protocols and Security, user 
authentication, starting and stopping EFT Server, configuring remote administration, configuring 
EFT Server's SMTP connections, and various other procedures related to configuring the way in 
which clients connect to EFT Server. 

 Configuring Server Administrators. This section provides information regarding creating and 
managing EFT Server administrators. 

 Configuring Sites. This section provides information regarding creating and managing 
connections to EFT Server. 

 Configuring Users and User Setting Levels. This section provides information regarding creating 
and managing users and User Setting Levels (to control access to EFT Server resources), and 
configuring Passwords, Connection Protocols, Transfer and Connection Settings, and how to 
automatically disconnect users. 

 Configuring Groups. This section provides information for creating and managing Groups, which 
set user virtual file system (VFS) permissions to folders.  

 Virtual File System. This section provides information about EFT Server's Virtual File System 
(VFS), which allows you to grant access to files and folders on your system based on user and 
Group permissions.  

 EFT Server Commands. This section provides information regarding defining Commands to use 
with Event Rules to run executables, batch files, and scripts automatically when specific events 
occur in EFT Server.  

 Event Rules. This section provides information regarding how to specify that an action is to occur 
when an event takes place and/or a condition is present. (e.g., send an e-mail when a file is 
uploaded). 

 Auditing and Reporting Module (ARM). This section provides information regarding using the 
Auditing and Reporting module to generate predefined and custom reports of EFT Server 
activities. 

 DMZ Gateway Server. This section provides information regarding configuring and managing 
DMZ Gateway Server to provide secured communications with EFT Server behind intranet 
firewalls without requiring any inbound firewall holes between the internal network and the DMZ. 

 HS-PCI Module. This section provides information regarding configuring EFT Server for use with 
the HS-PCI module for high security and/or compliance with the Payment Card Industry Data 
Security Standard. 

http://www.globalscape.com/support/eft.aspx
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 Web Transfer Client. This section provides information regarding configuring the browser-based 
file transfer client that allows users to transfer files to/from an EFT Server using a connected Web 
browser. 

 Secure Ad Hoc Transfer Module. This section provides information regarding configuring the 
Secure Ad Hoc Transfer module to allow internal users to send and receive large e-mail file 
attachments to recipients outside of your organization quickly, reliably, and securely, all without 
having to manually create or maintain FTP accounts on EFT Server. 

 AS2 Module. This section provides information regarding configuring and using EFT Server's AS2 
(Applicability Statement 2) module to exchange structured business data securely using the 
HTTP or HTTP/S protocol.  

 EFT Server's COM Interface. This section provides information regarding the programmatic 
interface that allows you to control EFT Server from your own custom applications using any 
COM-enabled programming language 

 Getting Help. This section provides information regarding how to use this help file and how to 
access online customer support services. 



 

27 

Installing and Activating the Software 

The topics below provide information regarding installing and activating EFT Server, and configuring EFT 
Server in the network. 

EFT Server Deployment Scenarios 

You have several options for how you configure EFT Server in your network architecture. Some common 
deployment scenarios are described below. If none of these scenarios exactly meets your needs, 
GlobalSCAPE's Professional Services team can work with you to design a custom architecture, assist 
with installation and initial configuration, and help you create custom scripting, Event Rules, Commands, 
and external user databases.  

EFT Server in the Demilitarized Zone (DMZ) 

In the most basic deployment scenario, both end users and business partners (clients) communicate with 
EFT Server as it resides in your organization's DMZ. All authentication directory service quests and data 
storage occur inside the demilitarized zone.  

EFT Server can be configured to forward all received data to the back-end network to mitigate the risks 
associated with storing it in the DMZ. This architecture, commonly known as store and forward, means 
that data only resides in the DMZ temporarily before it is offloaded to a back-end system for processing or 
storage. This store-and-forward architecture requires a hole to be punched through the firewall in west-to-
east fashion, a deviation from security best practices. This architecture is the one most commonly 
employed by competitors to GlobalSCAPEôs EFT Server solution. 

 

EFT Server and DMZ Gateway Deployment 

The ideal security solution is to implement a two-tier architecture comprised of EFT Server deployed 
behind the corporate firewall and EFT Serverôs DMZ Gateway Server deployed inside the demilitarized 
zone. This setup is known as a streaming or pass-through configuration.  

 

http://www.globalscape.com/support/professional_services.aspx
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Hybrid Configuration 1: EFT Server to EFT Server 

Various hybrid approaches exist consisting of multiple servers in a variety of configurations for different 
business use cases. Take for example a scenario in which the majority of traffic is outbound push with 
occasional in-bound pull, initiated by an automated script or batch process. In this scenario, data is 
generated behind the corporate firewall, then forwarded from one EFT Server to another EFT Server that 
resides in the DMZ for client pick-up, or directly from the back-end server to a destination server residing 
at the partnerôs location.  

 

The business need for placing EFT Server in the DMZ often stems from the need to pre- or 
post-process data as it moves through the DMZ, such as performing an anti-virus scan or an 
encryption procedure.  

 

Hybrid Configuration 2: Two EFT Servers and a DMZ Gateway 

In this hybrid deployment scenario, a client-initiated push and/or pull transaction is brokered through DMZ 
Gateway Server, and outbound push transactions are initiated by EFT Server, either from with the 
corporate firewall, or from an EFT Server residing in the DMZ. In this example, the partner is equipped 
with a file transfer server to service outbound push operations initiated by EFT Server. 
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EFT Server X 2 & DMZ Gateway X 2Setup in a Server Cluster 

In the architecture illustrated below, 2 EFT Servers and 2 DMZ Gateway Servers in a server cluster meet 
business continuity requirements requiring the duplication of servers to provide a fail-over cluster. 

 

System Requirements 

The GlobalSCAPE Quality Assurance team tests our products with a variety of operating systems, 
software, and hardware. It is possible for EFT Server and DMZ Gateway to function with other operating 
systems, software, and hardware, but is only tested and approved for use with the following: 

 Windows 2000, Windows XP Pro, or Windows Server 2003  

o EFT Server and DMZ Gateway Server have known issues with Windows Vista or 2008 
(planned support by Q4-08) 

o For information about using EFT Server on 64-bit systems, refer to knowledge base 
article Q10209 - FAQ: Is EFT Server available in a 64-bit version?  

 x86 compatible processor (tested with 600 MHz dual zeon to 3Ghz dual core)  

 1GB RAM (More RAM could be required for high-density, non-EDI file transfers over the AS2 
protocol. AS2 transfers can use up to 40% of the Server's RAM for concurrent file transfers.) 

 1024x768 resolution or higher display (required for the Administrator Interface)  

 Microsoft® ActiveX Data Objects (ADO) (required for Auditing and Reporting)  

 MSDE, SQL Server Express, SQL Server (required for Auditing and Reporting)  

o MSDE database has a 2GB limit, or approximately one million transactions.  
o For information about using Oracle, contact your account representative or refer to 

knowledge base article Q10411 - HOWTO: Windows Registry Settings.  

 EFT Server and DMZ Gateway Server must be installed on a separate computers  

 

The Server service runs under a user account, which must have full administrative rights to the folder 
in which you install EFT Server. With administrative rights, the service can save all your settings. If 
the service does not have administrative rights, you will lose settings and user accounts whenever 
you restart the EFT Server service, and you will need to reset permissions on the computer on which 
the Server service is running. 

EFT Web Transfer Client Requirements 

 Java 1.4.2 (J2SE) ï JRE 1.6.0_05  

 Internet Explorer 6.0 and 7.0 (Win) with latest OS/browser patches (as of May ô08) with 
JavaScript and cookies enabled  

http://kb.globalscape.com/article.aspx?id=10209
http://kb.globalscape.com/article.aspx?id=10411#EnableOracle
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Best Practices for Configuration and Validation 

Below is a collection of suggestions and guidelines for installing, configuring, and deploying EFT 
Server and/or DMZ Gateway software in a production environment. 

Development Lab Environment 

As with any mission-critical software or hardware, it is recommended that a testing, validation, 
development, or usability lab be established to provide a "sandbox" into which EFT Server and DMZ 
Gateway Server software can be deployed. This initial deployment allows for validation of the 
interoperability with other dependent components as well the validation of expected usage scenarios. 

The lab environment should emulate (if not duplicate) the production environment at a network 
topography and application level. To do this, a clear vision of the production network and the proposed 
deployment of EFT/DMZ Gateway must exist. Typical deployments of EFT Server and DMZ Gateway 
Server consist of many other components from the enterprise, including Active Directory Server, SQL 
Server, SMTP Server, and a storage system such as a SAN. For DMZ Gateway Server, a firewall such as 
Microsoft ISA might be applicable. Finally, some deployments also include Microsoft Clustering, in which 
case various components are replicated to provide clustered resources. 

For increased business continuity and risk mitigation, you should use the development lab environment 
as the starting point for any configuration changes in the system. That is, make the change in 
development and validate it prior to making the change in production. 

 

A good testing tool is CuteFTP Professional. 

Configuration Validation  

The installation and configuration of EFT Server in either a lab or production environment should be 
validated by the EFT Server administrators/operators to ensure that the functions are working as 
expected. Use the checklist below to validate key items for an EFT Server and DMZ Gateway Server 
deployment.  

Service 

 

Make sure that the GlobalSCAPE EFT Server service is started on the computer.  

 

Make sure that the service is listening on the expected IP:PORT socket addresses on EFT Server. (To view 
the listening sockets, use "netstat -ona" from a command line or an application such as PrcView or 
TcpView.)  

 

Check the Event Viewer log to ensure that there are no errors in the Application log related to EFT Server or 
DMZ Gateway Server. 

 

Confirm that EFT Administrator shows the status of the system when it is launched and connected to EFT 
Server.  

EFT Server User Management  

 

For each Site on EFT Server, ensure that the expected user accounts exist.  

 

To ensure that authentication is working as expected, attempt to log in to EFT Server as a user account on 
the system (using any protocol). 

 

To confirm permissions for the user account are working as expected, attempt a file transfer. 

Protocol/Network  

 

For each protocol enabled on EFT Server, attempt a connection directly to EFT Server using a client that 
supports that protocol. 

 

For each protocol enabled through DMZ Gateway Server, attempt a connection to the appropriate DMZ 
Gateway IP:PORT and confirm that this route works as expected.  

http://www.globalscape.com/cuteftppro/
http://www.cnet.com.au/downloads/0%2c239030384%2c10610163s%2c00.htm
http://www.cnet.com.au/downloads/0%2c239030384%2c10652554s%2c00.htm
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Auditing/Logging  

 

View the audit traces generated by the validation steps above.  

 

Confirm that the Auditing and Reporting module database has been populated with appropriate data (using 
either EFT Server Reporting interface or direct access to the SQL Server being used).  

 

Confirm that the text log files generated by EFT Server have been populated with the appropriate data.  

Event Rules/Workflow 

Each customer has a unique set of Event Rule/workflow requirements, but these are the general validation steps. 
Confirm the following are working as expected:  

 

E-mail notifications. Test e-mail notifications by triggering an Event Rule that has an e-mail 

notification Action to confirm that Event Rules fire and that the SMTP configuration is correct.  

 

PGP operations. Confirm that OpenPGP keys are configured properly.  

 

Move/Copy/Download actions. Initiate Event Rules that perform remote file uploads/copies/download so 

that connectivity originating from EFT Server to a remote system is properly configured. In this step, also 
confirm that a log file is generated that audits outbound connection information (a "cl*.log" file in the 
designated Server Log File location).  

 

Custom Commands. EFT Server is responsible for triggering those external commands, so that is what 

should be validated with respect to EFT Server. Any actions carried out by those external tools should be 
validated independently. Confirm that a "CMDOUT.LOG" file is generated in the EFT Server installation 
folder as the result of an invoked Custom Command.  

 

Folder Monitor Rules. Ensure that the Event Rules are properly enabled and responsive to files added to 
the folder being monitored. 

Cluster/Failover Testing  

 

For cluster deployments, the failover and failback operations of the cluster should be confirmed. After a 
failover/failback, confirm that the newly active server behaves properly; that is, the failover is transparent 
and the configuration/operation is as expected. This can be summarized by the prior set of tests operating 
against the newly active node in the cluster.  

Load Testing  

 

If you expect high volumes of traffic or back-end processing within EFT Server, you should verify that the 
resource utilization levels on EFT Server are within acceptable tolerances. There are numerous load-testing 
tools available, ranging from simple batch files running command-line FTP to highly complex synthetic 
transaction generators. GlobalSCAPE's Quality Assurance team performs load testing of our servers as part 
of our standard validation process for releasing software and can provide guidance and/or tools to assist in 
load testing.  

Numerous other features can be validated within EFT Server. The above set represents the key elements 
that are most often used and are the most critical to successful operation in a production environment. 

Prescriptive Guidance for Maintenance 

The following are guidelines for maintaining the good health of an EFT Server and DMZ Gateway server 
deployment, and reducing long-term costs of maintenance and operation. 

Configuration Backup - For disaster recovery and business continuity, it is important to keep backups of 
EFT Server and DMZ Gateway server configuration. Backing up the configuration can be accomplished 
with a variety of tools such as Symantec Backup Exec, Ghost / VMWare to make images of the system, 
GlobalSCAPE Continuous Data Protection (CDP), or even a simple script file.  

Database Backup and Truncation - If you are using the Auditing and Reporting module (ARM), the SQL 
Server to which the audit records are stored should include EFT Server ARM tables as part of the typical 
database maintenance plan. This includes proper monitoring of the tables and transaction logs, backing 
up the data and having a retention policy to archive (or purge) old data.  
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Restarting Services - Given the facility of the Microsoft Cluster in failing over and failing back while 
providing high resource availability, it is recommended that you design a maintenance schedule in which 
the EFT Server service is cycled at least once per quarter to once per month. Failing over to the backup 
node, restarting the service, then failing back and restarting the other node would suffice in re-
establishing a baseline state of the EFT Server service to ensure optimal health.  

Data Archival and Retention - It is suggested that a policy be put in place and enforced by which old 
data is periodically archived and/or purged, because no disk is limitless and performance can degenerate 
as more files are added to the Server. Therefore, a storage management policy should include regular 
inspection of available hard disk space and health (error count, fragmentation, etc.) as well as archiving 
and/or purging user data and Server Log Files (CMDOUT.log found in the application folder, and all other 
logs found in the Log folder specified at the Server level in EFT Server).  

Performance Counter Monitoring - DMZ Gateway Server provides a Performance Counter object to the 
computer on which it is installed. This object provides a standard Windows mechanism to view activity 
through DMZ Gateway Server and, in general, assess the fundamental health of the system as a whole. It 
is recommended that the enterprise operations practices include monitoring the key performance 
counters (automatically is preferred) by adding the "EFT Gateway" performance object to Microsoft's 
Perfmon, and monitoring items such as "Active Sites" (indicates up/down state of EFT Server through 
DMZ Gateway) and "Active Client Connections" (indicates activity through the DMZ Gateway to EFT 
Server).  

Event Log Alerting - EFT Server will log error conditions to the standard Windows Event Viewer. It is 
recommended that the operations team for an enterprise include the EFT Server error checks in their 
monitoring techniques, looking for an ERROR event generated with a source of "GlobalSCAPE EFT 
Server" or "GlobalSCAPE EFT Gateway" service.  

Procedure for Cold Standby Setup 

Below are few recommendations for achieving a backup server image that is ready to be quickly turned 
on and accept "real" traffic. 

 

In all situations, if we are copying a configuration file from one system to another, care must be 
taken with hardware-specific resources, such as IP addresses, physical paths/partitions, and so 
on. If possible, it is recommended that the EFT Server configuration use the generic "All 
Incoming" IP Address for incoming socket connections so that differences in computer IP 
addresses do not prevent proper operation of the system if the Cold Standby comes online. 
 
Furthermore, we must take care with the connections and IP-access restriction lists between EFT 
Server and DMZ Gateway. If the DMZ Gateway is configured to allow only one EFT Server IP 
address to connect to it, then the Cold Standby server must have the same IP address to 
connect; alternately, the DMZ Gateway IP access list must include all possible IP addresses 
(possibly a Class C subnet) so that multiple servers from the approved network segment may 
connect. 

Virtualization Software - A great solution from a cost- and resource-saving standpoint, it is also quite 
easy to manage due to the "software" nature of the solution. The approach would be to create an image 
within a Virtual system (using a tool such as VMWare or Microsoft Virtual PC) by installing and activating 
EFT Server or DMZ Gateway server software. Once this is done, the steps required to bring the system 
online include first copying the configuration files (which were backed up using a process described 
above), then bringing the virtual image online and starting the service.  

System Backup Software - Another quick and easy option is to create a disk or system image of a 
configured EFT Server or DMZ Gateway server (using a product such as Norton Ghost); when a Cold 
standby needs to be "stood up" and made hot, the image can be installed on a computer, backup 
configuration copied, and the service started.  
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Periodic Backup to Cold Standby Machine - If resources permit, the quickest way to get a "Cold" 
computer to become "Hot" is to have a computer dedicated to this function. It should have EFT Server 
and/or DMZ Gateway server installed and activated, but the service should be stopped. A process to copy 
the configuration periodically from the "Hot" server to the "Cold" server would keep the two in synch, and 
if the "Hot" system goes down, the "Cold" system can simply start the service.  

EFT Server and Microsoft Clustering Services 

Configuring Clustering with EFT Server 

 

If you are upgrading EFT Server in a cluster, refer to Upgrading EFT Server in a Cluster. 

Set up EFT Server in a clustered environment using Microsoft Clustering Services or GlobalSCAPEôs 
monitoring utilities and achieve high availability through failover clustering.  

If you have Microsoft Clustering Service (MSCS) deployed, you can use its built-in Resource Monitor to 
manage the availability of EFT Server. MSCS can manage EFT Server as a generic service.  

Clustering setups vary between operating systems, hardware resources used, and various other factors. 
If you have never set up a server cluster before, please consult your Windows documentation or the 
Cluster Administrator help file for detailed instructions on setting up server cluster prior to proceeding. 
Setting up clustering on Windows 2000 Servers is beyond the scope of this paper; a brief overview of how 
to set up clustering on Windows 2000 is included, but the focus of these instructions is for setting up EFT 
Server in a pre-existing clustered environment. Below are some illustrations of clustering with EFT Server. 

 

We have not tested clustering with the DMZ Gateway Server. 

Active-Passive Fail-Over Configuration Sharing, Option 1 
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Active-Passive Fail-Over Configuration Sharing, Option 2 

 

Network Load Balancing (NLB) Active-Active Fail-Over Cluster 

Presently, EFT Server supports NLB clusters only for anonymous access sites, or for account-driven sites 
that allow temporary downtime to synchronize configuration and permissions. 
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EFT Server + DMZ Gateway Fail-Over Cluster 

Server cluster solutions can include EFT Server and EFT DMZ Gateway configuration, managed by a 
cluster services manager. 

 

 To find out which hardware is compatible with MSCS, refer to Microsoftôs hardware compatibility 
list at: https://winqual.microsoft.com/default.aspx 

 To learn more about MSCS, search for "clustering" on the Microsoft Developer Network Library 
at: http://msdn2.microsoft.com/en-us/library/default.aspx 

 For information about clustering on Windows 2003 Server, review the article "Introducing 
Microsoft Cluster Service (MSCS) in the Windows Server 2003 Family" at: 
http://msdn2.microsoft.com/en-us/library/ms952401.aspx 

 Deploying EFT Server in a clustered environment as described in this section is typically the most 
reliable method to achieve high availability and mitigate down time. For more information specific 
to clustering with EFT Server, contact GlobalSCAPE Customer Support. 

 A PDF of configuring EFT Server in a cluster is available at: 
http://www.globalscape.com/files/globalscape_eft_clustering_howto.pdf 

Prerequisites for EFT Server in a Clustered Setup 

Operating System requirements 

Microsoft Clustering Service as available on:  

 Windows 2000 Advanced Server name service  

 Windows Server 2003 R2 Enterprise Edition 

 Windows Server 2003 Datacenter Edition  

Hardware and resource requirements  

 A complete system for each node of the cluster (minimum of two) 

 A shared disk resource such as DAS, or SANS, preferably configured as a RAID-redundant array  

 A disk quorum for disk and resource management; a minimum of two adapters per system (one 
for internal cluster communications, and another for public access)  

Skill Set  

A systems or network administrator familiar with the organizationôs structure and skilled in networking, 
Active Directory (AD), and cluster administration. 

First Step: Configure the Server Cluster 

https://winqual.microsoft.com/default.aspx
http://msdn2.microsoft.com/en-us/library/default.aspx
http://msdn2.microsoft.com/en-us/library/ms952401.aspx
http://www.globalscape.com/support/
http://www.globalscape.com/files/globalscape_eft_clustering_howto.pdf
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Configure the Server Cluster 

Perform the steps below to configure clustering before setting up EFT Server on the system. 

1. Make sure the hardware is set up correctly and there is a shared disk resource, disk quorum, 
hub, or switch with Ethernet hookups between the two servers, as well as adapters for the 
crossover and for outside access, an adequate uninterruptible power supply (UPS) support for 
each device, and so on.  

2. Make sure you install an operating system that supports clustering on each system. If available, 
give Internet access to each system because you will need to activate EFT Server on each node. 
If you cannot provide Internet access, you will have to activate the product manually (see 
Activating the Software). 

3. Install Active Directory (AD) and configure the domain name service (DNS) on the first node. 
Choose one of the EFT Servers to be node 1. The administrator password cannot be left blank.  

4. Create an account for the cluster in AD with a non-blank password and assign the account to the 
administrators group.  

5. Join the second node to the AD domain as another domain controller. Both nodes must be 
domain controllers.  

6. Reboot, then log in to the first node with the cluster account.  

7. Launch the Cluster Configuration Manager from the Add/ Remove Windows components dialog 
and create a new cluster. 

8. Complete the new cluster creation wizard, providing a name for the cluster and cluster account 
credentials. Allow it to manage the disk, quorum, and other shared resources. Verify the quorum 
drive is correct, and select the private network option. Use one adaptor for the cluster nodes and 
the other for the public network. Specify the IP address for managing the cluster.  

9. Run the cluster configuration tool on the second node and configure it to be an additional node in 
the cluster. You will need to provide the cluster name and appropriate cluster account credentials.  

10. After you have completed the cluster configuration wizard, verify that the two nodes are set up 
properly from the cluster administrator dialog box. (To access the cluster administrator, click Start 
> Programs > Administrative Tools > Cluster Administrator.)  

11. Select the Resources folder in the left pane, right-click, select New Resource, then create the 
shared IP address on which the EFT Servers will listen. Note that EFT Server captures the IP 
address when the GlobalSCAPE EFT Server service starts, so if the IP address is changed after 

that, the Service must be restarted to capture it.  

Next Step: Set Up EFT Servers to Run in a Clustered Environment 

Set Up EFT Servers to Run in a Clustered Environment 

 

 If you are upgrading EFT Server in a cluster, you MUST bring down BOTH nodes BEFORE 
performing the upgrade. Refer to Upgrading EFT Server in a Cluster instead of this topic. 

After you install and configure clustering on the system, perform the following procedure to configure EFT 
Servers in the cluster.  

1. Install EFT server on the active node 

2. Install EFT Server on the active node and select the shared disk drive as the installation directory.  

3. When the install completes, launch the product. Connect to EFT Server using the EFT 
Administrator account that you created during installation.  

4. Activate the software in Full or Trial mode. Use your primary serial number if activating the 
primary node and your backup serial number if activating the backup node.  

5. Once activated, exit EFT Administrator without configuring a new Site.  
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6. Open the Services dialog box (in Windows Administrative Tools), open the GlobalSCAPE EFT 
Server service Properties dialog box, then switch the startup mode from Automatically to 
Manual.  

7. Now stop the GlobalSCAPE EFT Server service, close the Services dialog box, and launch the 

Cluster Administrator. 

8. In the Cluster Administrator, make the second node active: In the left pane, click Groups, right-
click the appropriate cluster and disk groups, then click Move Group. All resources should move 
from the first node over to the second node so that the second EFT Server installation succeeds. 
If not, the shared disk will lock for the second node. It may take a few moments for the resources 
to switch over.  

9. Install EFT Server on the second node once it is active (also to the shared directory), following 
steps above, and then exit the Services dialog box without stopping the GlobalSCAPE EFT 

Server service.  

10. Launch EFT Administrator, connect to the EFT Server service on the second node, and configure 
EFT Server.  

11. Create a new Site: On the EFT Administrator main menu, click Configuration, then click Create 
New Site. 

12. If you are using the built-in authentication services, make sure you specify the shared disk drive 
as the location for saving your user database (.aud) file.  

 

Clusters can be configured as member servers but must all be members of the same domain 
and always have contact with the global catalog server. In most cases, the cluster is 
independent of the network in a DMZ, and would be Domain Controllers.  

13. Confirm that the default EFT Server root folder is pointed to a location on the shared disk drive, 
then click Finish.  

14. On the Site Options tab, specify the home IP for the Site. You can select All Incoming or 
Shared IP. Both methods work, but the preferred method is to specify a shared IP address. Be 
sure to use the IP addresses you specified in Set up the Server Cluster. 

15. Create and configure users, Groups, Event Rules, and the Virtual File System, then close EFT 
Administrator.  

Next Step: Integrate EFT Server into the Cluster 

Integrate EFT Server into the Cluster 

After you have Set Up the Server Cluster and Set Up EFT Servers to Run in a Clustered Environment, 
EFT Server configuration is now identical for both servers because both servers are using the same 
configuration file stored on the shared disk, are saving data to the same place, and share the same 
outside-facing IP.  

To integrate EFT Server into the cluster 

1. Open the cluster administrator. In the left pane, right-click the Resources folder, click New 
Resource, expand the Create New Resource list, then click Generic Services.  

2. Choose both nodes, select all resources as dependencies, then type the exact service name as 
displayed in the Windows Services dialog box (GlobalSCAPE EFT Server). Do not choose to 

replicate the registry settings.  

Next Step: Complete Configuration and Test  
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Complete Cluster Configuration and Test  

After you Set Up the Server Cluster, Set Up EFT Servers to Run in a Clustered Environment, and 
Integrated EFT Server into the Cluster, you should have both nodes configured with shared resources, 
including a shared IP address, disk array, quorum, and two EFT Servers. Perform tests to ensure the 
system was correctly configured. 

 Go to each node and switch groups, which will set one node or the other as active.  

 Unplug one of the nodes from the UPS and verify that the switchover takes place (usually < 30 
seconds before the failover takes control).  

Your cluster setup is now complete. 

 

If one Server goes down, you lose any transactions in progress until the failover goes online.  
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Upgrading EFT Server in a Cluster  

If you are upgrading an EFT Server that is part of a cluster, follow the procedures below.  

To upgrade EFT Server in a cluster 

1. Obtain new installation file(s) 

2. Back-up the Server's .aud, .cfg files, and if applicable, SFTP, PGP, or SSL keys/certificates.  

3. Verify your administrator login credentials by connecting to the Server service using the 
Administrator interface. 

4. Bring down the cluster (from within the cluster manager).  

5. It is critically important that EFT Server service is STOPPED on both nodes! Verify that the 
EFT Server service is stopped by logging in to each node and inspecting the service control 
panel. For extra assurance you can change the startup type to Manual from Automatic. (Make 

sure to switch it back before you bring the cluster back up in step 8 below.) 

6. Run the installer on the first node and select Repair when prompted. (Do NOT click Modify.) 

7. Run the installer on the second node and select Repair when prompted. (Do NOT click Modify.) 

8. If you changed the Server service startup to Manual in step 4, change it back to Automatic.  

9. Bring the cluster back up.  

10. Verify the upgrade was successful: 

a. Verify that EFT Server is running on the primary node. 

b. Disable the primary node and verify secondary node starts up. 

c. Log in to the Server via the Administrator interface and verify the version number is the 
same on both nodes (click Help, then click About). 

Installing Enhanced File Transfer (EFT) Server and Administrator 

This topic provides instructions for installing the EFT Server service, EFT Administrator, and the Microsoft 
SQL Server 2000 Desktop Engine (MSDE) version 8 for auditing and reporting. If you are using a SQL 
database for auditing and reporting, you do not have to install the MSDE database. Refer to Using a SQL 
Database as the Auditing Database. 

If you are upgrading from a previous version of EFT Server, refer to Upgrading EFT Server. 

 

If you are using Windows 2000 for your server installation and will be using ARM, you must update 
MDAC prior to installation. You can find the latest update at 
http://msdn.microsoft.com/data/ref/mdac/downloads. This does not apply to Windows XP or 
Windows 2003, as they come with a newer version of MDAC that is compliant.  

To install EFT Server and Administrator  

1. Start the installation wizard and follow the instructions in the wizard.  

2. Read the license agreement and click Yes to accept it.  

3. Specify the folder in which to install the software. The default is C:\Program 
Files\Globalscape\EFT. Click Browse to specify a different folder.  

4. Click Next. The Select Components dialog box appears.  

5. Select the check boxes for the components that you want to install:  

 Select Enhanced File Transfer Server Service (cftpstes.exe) and the Administrator 
Interface (cftpsai.exe) to install them both on this computer.  

http://msdn.microsoft.com/data/ref/mdac/downloads/
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 Select only the Administrator Interface for remote administration of an EFT Server 
installed on another computer.  

 Select MSDE database for auditing & reporting to install the Microsoft SQL Server 
2000 Desktop Engine database to use with the Auditing and Reporting module. If you are 
planning to use a separate database, you can clear this check box, unless you plan to 
use it for testing. Refer to Using a SQL Database as the Auditing Database if you decide 
not to use MSDE.  

6. Click Next. The Administrator Account Settings dialog box appears. 
 

 

7. Create a user name and password for the administrator account for connecting to EFT Server 
from EFT Administrator.  

 

Remember your user name and password; you need them to connect to EFT Server. If you 
later forget your password, refer to Forgetting the EFT Server Administrator Password. 

8. Click OK. If you chose to install MSDE, the Database Login Details dialog box appears. 
 

 

9. Create a username and password for EFT Server's connection to the MSDE database. The 
username and password are used on the Auditing tab in EFT Administrator to configure the 
connection to the database.  
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10. Click Next. The installer installs the selected components and creates the database (if you chose 
to install it), then the Finished dialog box appears. 
 

 

11. If you want to read the release notes, select the View README file check box. If you want to 
read it later, the file, notes.txt, is stored in the EFT Server installation directory.  

12. The Launch Administrator Interface check box is selected by default. If you do not want to 

open EFT Administrator, clear the check box.  
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13. Click Finish. If the Launch Administrator Interface check box was selected, EFT Administrator 
appears for you to log in. EFT Administrator is used to configure EFT Server. You can also open 
EFT Administrator by clicking Start > Programs > GlobalSCAPE > GlobalSCAPE EFT.  
 

 

14. Do one of the following: 

 If you installed the Server service on this computer, leave This computer selected.  

 If you installed only the Administrator to administer EFT Server on another computer, 
click A remote computer.  

a. Click New. The New Administrator Connection wizard appears. 

b. In the Label box, provide a descriptive name for the EFT Server computer. This name will 

appear in logs and reports. 

c. In the Host address box, provide the IP address of the EFT Server computer. 

d. In the Port box, provide the port number of the EFT Server computer. 

e. Click Next. 

15. In the Username and Password boxes, provide the login credentials that you created in step 7. 

16. Click Connect. The EFT Administrator appears.  
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Next Steps:  

1. Activate the Software  

2. Set Windows System Services  

 

The Server service runs under a user account, which must have full administrative rights to 
the folder in which you install EFT Server. With administrative rights, the Server service can 
save all your settings. If the service does not have administrative rights, you will lose settings 
and user accounts whenever you restart the Server service, and you will need to reset 
permissions on the computer on which the Server service is running. 

 

 

If you are using Microsoft IIS, see Running EFT Server and Microsoft IIS on the Same Computer. 

Upgrading the Software 

If you are upgrading or updating EFT Sever, use the following procedure. The upgrade or update process 
does not reset or otherwise affect your EFT Server configuration or user settings. It is a good idea to read 
the Release Notes before you begin. 

 

Important Pre-Installation Information: 

 If you want to test or verify an update prior to introduction into your production environment, 
please contact GlobalSCAPE technical support for a trial registration serial number. Do not 
use your production serial number for testing purposes. 

 If you are adding an EFT Server add-on module, you may receive a new activation serial 
number. If so, then it may be necessary to activate the software when you start it for the first 
time.  

 If you are currently running EFT Server 3 or 4, please contact support for an EFT Server 5 
upgrade activation serial number prior to starting the upgrade process.  

 It is very important that the Secure Ad Hoc Transfer (SAT) module use the same version of 
the SFTPCOMInterface.dll used by the EFT Server to which SAT is connecting. Upgrading 
EFT Server might require also updating the SFTPCOMInterface.dll for the SAT module. 
Refer to Upgrading Secure Ad Hoc Transfer for details. 

 If you are upgrading in a clustered environment, refer to Upgrading EFT Server in a Cluster 
or contact GlobalSCAPE support for assistance. 

 If you are moving a Server from one computer to another, contact the GlobalSCAPE 
customer service team or your account manager so that we can adjust your account on our 
activation and registration server. Activation on the new computer will not be possible until 
the adjustment is made. 

To upgrade the software 

1. Download the most recent release of the software from the GlobalSCAPE Web site and save it to 
your desktop.  

2. Document the administrator user name and password for the existing EFT Server/DMZ Gateway 
Server. 

3. Close the Administrator interface and stop the Server services. 

4. As a precaution, back up the existing installation directories and any other files you may 
have installed elsewhere. The default installation paths are C:\Program 
Files\GlobalSCAPE\EFT\ and C:\Program Files\GlobalSCAPE\EFT DMZ Gateway. 

5. Launch the installer, click Repair, then click Next and follow the instructions in the wizard. 

6. When the wizard is finished, restart the Server services. 

 

http://www.globalscape.com/support/eft.asp
http://www.globalscape.com/downloads/
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If EFT Server and DMZ Gateway Server are both installed, both Server services should be restarted, 
even if only one Server is updated. 
 
If EFT Server and the Secure Ad Hoc Transfer module are installed on the same computer, then the 
upgrade process for EFT Server will also upgrade any files required by SAT. For example, the COM 
object is registered on the computer by EFT Server and used by SAT; however, the IIS service must 
be restarted so that ASP.NET (hosted by the "aspnet_wp.exe" process) will release any references 
to the existing COM object and reload the new one. You can do so in the Windows Services dialog 
box, or open a Windows command prompt and type iisreset.  

If you need additional information or help, visit GlobalSCAPE's EFT Server Support Center at 
http://www.globalscape.com/support/eft.asp.  

Activating the Software (EFT Server and Add-On Modules) 

You must activate the software with either a full or trial serial number. Each of EFT Server's add-on 
modules are available during the EFT Server trial and must be activated separately. 

To activate online, you must be connected to the Internet, and registration must be performed through 
EFT Administrator on the EFT Server computer. You cannot activate through a remote installation of EFT 
Administrator. 

You can also e-mail the manual registration information to GlobalSCAPE Technical Support, as described 
below. GlobalSCAPE will confirm your registration and send you a .reg file. You can send the e-mail from 
any computer with Internet access, and then transfer the .reg file to the computer on which you are 

installing the software. 

 If you are moving a Server from one computer to another, contact the GlobalSCAPE customer 
service team or your account manager so that we can adjust your account on our activation and 
registration server. Activation on the new computer will not be possible until the adjustment is 
made. 

 If you are upgrading a Server residing in a clustered environment, contact GlobalSCAPE 
technical support for assistance. 

 If the Server is installed on Windows 2003, log in to the Server as a user with an account having 
administrator privileges instead of "Local System" privileges to write the .reg file to the registry.  

To activate EFT Server and/or add-on modules 

1. Start EFT Administrator and provide your EFT Server administrator credentials (created at 
installation). 

 If this is your first time attempting to connect, you are prompted to enter a serial number 
or trial serial number. 

 If you are activating a purchased license for EFT Server, click Enter EFT Serial Number.  

 If you are activating a trial use of EFT Server, click Enter Trial Serial Number.  

 If you previously logged in with a trial serial number and want to activate a purchased 
license, on the main menu click Help, then click one of the following: 

o Enter EFT Server Serial Number 

o Enter Web Transfer Client Serial 

o Enter PCI DSS HS Serial 

o Enter AS2 Serial  

 

 

http://www.globalscape.com/support/eft.asp
http://www.globalscape.com/support/eft.asp
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Occasionally, when the software is in trial mode, the "Validating Trial Status" 
message appears: 
 

 
 
When in trial mode, depending on your computer, the network, and the Registration 
Server activity, the EFT Server service can take from 30 seconds to 2 minutes to get 
into the proper state. While the EFT Service is in the process of determining the trial 
state of the service, EFT Server prevents you from logging in and instead shows this 
message. You usually will see this message if you have a trial activated EFT Server 
and the EFT Administrator is attempting to connect to the EFT Server service while 
the service is not yet fully started. 

The Online Registration dialog box appears. 

 

2. In the Serial Number field, provide your serial number. 

3. In the Name field, provide your name and/or your company name. 

4. (Optional) If you have changed the name on the account since registering the trial or previous 
serial number, select the Update user information check box. 

5. If you are behind a proxy, click Proxy and configure the proxy settings. 

 

If a firewall or a proxy server is in use, your network administrator should ensure that 
outbound port 80 is open during the registration process. 

6. Do one of the following: 

 To activate online, click Register. You should receive a message confirming registration. 
Click OK. Registration is complete. 
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 To activate manually, select the Register manually check box. The Online Registration 
dialog box expands. 
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a. Provide the required information (all fields are required except Company Name 
and Fax Number), then click Register. The Manual Registration dialog box 
appears.  
 

 
(Personal information removed from illustration.)  

b. Click Copy to Clipboard, then do one of the following: 

 If the computer on which you are installing the software has Internet 
access, click Register on the Web. 

 If the computer on which you are installing the software does not have 
Internet access, click Close, then do the following: 

a. Copy the text to a text editor, then copy the file to a computer 
with Internet access.  

b. Open the text file, select all of the text (CTRL+A), then copy the 
text to the clipboard (CTRL+C). 

c. In your Web browser, go to the GlobalSCAPE registration Web 
page, http://www.globalscape.com/register. 

The GlobalSCAPE Manual Registration Web page appears 
 

 

http://www.globalscape.com/register
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d. Follow the instructions on the GlobalSCAPE Manual 
Registration Web page, then click Register Me. 

e. If registration is successful, a .reg file download prompt appears 
in your browser. Save the file, then transfer it to the computer on 
which you are installing the software, if different. 

f. Stop the GlobalSCAPE EFT Server service (cftpstes.exe) 
before you write the .reg file to your registry.  

g. Double-click on the saved .reg file to write the information to 

your registry. 

h. Once the registry is successfully updated, you can safely delete 
the .reg file. 

i. Start the GlobalSCAPE EFT Server service.  

7. Cancel or close any open registration dialog boxes, then exit EFT Administrator and restart it. 

If you have any problems with registration, visit GlobalSCAPE Customer Support, at 
http://www.globalscape.com/support/customerservice.aspx.  

Setting Windows System Services 

The topics below provide the procedures for configuring EFT Server as a Windows service. 

Creating a Windows User Account for EFT Server 

The Server service runs under a user account, which must have full administrative rights to the folder in 
which you install EFT Server. With administrative rights, the service can save all your settings. If the 
service does not have administrative rights, you will lose settings and user accounts whenever you restart 
the EFT Server service, and you will need to reset permissions on the computer on which the Server 
service is running. 

To create a user account in Windows XP Professional or Windows 2000 

1. After you install EFT Server, open the Computer Management console. (e.g., on the Desktop, 
right-click My Computer, then click Manage.) 

http://www.globalscape.com/support/customerservice.aspx
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2. Expand the Local users and groups node, right-click Users, then click New User. The New 
User dialog box appears. 
 

 

3. Create the EFT Server user account (e.g., EFTUser), click Create, then click Close. 

4. Close the Computer Management console. 

5. In Administrative Tools, click Local Security Policy. The Local Security Settings dialog box 
appears. 
 

 

6. Expand the Local Policies node, then click User Rights Assignment. 
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7. In the right pane, in the Policy column, double-click Act as part of the operating system. The 
Properties dialog box appears.  
 

 

8. Click Add user or Group. The Select Users or Groups dialog box appears.  
 

 

9. Select the new user you just added (e.g., EFTServer), click Add, then click OK. 

10. If necessary, assign permissions for this user account in Windows. 

11. Assign EFT Server to the new user account and log EFT Server on as a service. 
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Set Windows NT Permissions for EFT Server 

After you have created a new Windows user account for EFT Server, use Windows' permissions to set 
the permissions for folders, files, or drives for the account. Permissions should be as restrictive as 
possible while still allowing EFT Server enough permissions to run.  

After it is installed, EFT Server has access to local folders and files. To run it as a service with 
permissions to the network and mapped drives, you must create an NT account for EFT Server, assign 
the GlobalSCAPE EFT Server service to the account, and log EFT Server on as a service. Using 
Windows NTôs permissions, set the permissions for files or drives of this user to be as restrictive as 
possible, while still allowing EFT Server to run. After carefully determining which files and network folders 
your users will need to access, gradually increase the permissions. 

 

Using NT Authentication, user permissions override EFT Server's permissions. For example, if EFT 
Server has read-only access to folder1, but user John Doe has read and write permissions to 
folder1, John Doe has those same permissions when he accesses folder1 through EFT Server. 

Windows NT permissions can be edited through the Security tab in the Properties of a file or folder. On 
the Security tab, select Permissions to display and edit the permissions for the object. The appearance 
of this dialog box is slightly different for files and directories, but in both cases, the following permissions 
can be granted to users or groups:  

 R (Read) 

 W (Write) 

 D (Delete) 

 P (Edit permissions) 

 O (Take ownership) 

Keep in mind that you have the option to grant or withhold read and write permissions. Read-only 
permissions are the most secure, because they allow users to access a file, but not to change it. For 
example, most users will need limited read access to the Windows folders (C, WinNT); however, most 
FTP Servers will not need any access to these directories at all.  

In addition to the individual permissions, Windows NT permissions also provide access levels that are 
simply pre-built sets of the existing permissions. Typically, you assign an access level to a user rather 
than granting individual permissions. One such access level is called "No Access," which does not 
contain any permissions.  

T o view and edit the permissions for a folder or file 

1. In Windows Explorer, right-click the file or folder, then click Properties. 

2. On the Security tab, click Permissions. The appearance of this dialog box is slightly different for 
files and directories and for different versions of Windows (W2K, XP, etc.). 

For more information about setting permissions to folders and files, refer to the Windows Help 
documentation for your specific operating system. (e.g., click Start > Help and Support, then search on 
keyword permission.)  

Logging EFT Server on as a Service 

 

The log on as a service permission is granted automatically in Windows XP Professional, 2003, 
and 2000. 

Follow the instructions below based on your operating system, or refer to the Microsoft Help pages. (Click 
Start, then click Help and Support.)  
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Windows XP Professional, Windows 2003, and Windows 2000  

1. In Administrative Tools, click Local Security Policy. The Local Security Settings dialog box 

appears. 

2. In the left pane, expand the Local Policies node, then click User Rights Assignment. The 
Policy name and Security Setting appear in the right pane. 
 

 

3. In the right pane, double-click Log on as a service. The Log on as a service Properties dialog 
box appears. 
 

 

4. Click the user you want to add (e.g., EFTServer), then click OK. 

Windows NT Permission Rules 

To secure your system, GlobalSCAPE recommends that you create a user account for EFT Server and 
grant restrictive permissions to that user account. When you are assigning permissions to individual 
folders or directories in Windows NT, you may want to reference the following rules. These rules differ 
somewhat from the VFS rules that govern EFT Server permissions. 

The rules below determine the permissions that are ultimately granted to a user in Windows NT: 

1. Explicit denial: All users or groups assigned "No Access" have no access  
 
If the user or a group that the user is in has been assigned "No Access," that user is explicitly 
prohibited from using the file, folder, or drive. No other permissions will change this. 
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2. Cumulative permissions: Permissions are combined when a user is not explicitly denied 
access 
 
If the user is not explicitly denied access, the user's permissions are combined. For example, if 
user Cal is given read and write permissions for Folder1, and Cal is also in a group that is given 
execute permissions for that folder, then Cal will be able to read, write, and execute files in 
Folder1. 

3. Implicit denial: A user or group that has never been granted any access at all will not be 
given access 
 
If the user or a group containing the user is not granted any permissions, that user or group will 
be denied access. Access must be specifically granted. 

Assigning the Service to a Windows User Account 

After you have installed EFT Server, created a Windows account for EFT Server, and assigned 
permissions to the account, you need to edit the service itself so that it will not run as a "System Account" 
(the default account choice). Running the service as System Account poses the potential hazard of giving 
users complete access to your system. 

To assign the service to a Windows user account 

1. Open the Windows Services dialog box.  

2. Right-click GlobalSCAPE EFTServer, then click Properties.  

3. Follow the Windows Operating System procedures for selecting an account under which the 
service will run. 

Windows Registry Settings 

EFT Server stores its configuration information in the Windows Registry, which contains profiles for each 
user of the computer and information about system hardware, installed programs, and property settings. 
EFT Server modifies the system registry as needed, and continually references this information during 
operation.  

To add a key to the registry, you can either edit it directly or create and execute a .reg file. When you add 
or edit these registry keys, you will need to restart EFT Server. 

 

These options are for advanced users only. Incorrectly editing the registry can severely 
damage your system. You should always back up (export a copy of) the registry before you 
make any changes to it.  
Certain keys below should be created in the EFT Server 3.0 folder, and others in the EFT 
Server 4.0 folder. Do NOT change the path to match your version of EFT Server.  

The registry keys described below are available in EFT Server for advanced system administration.  

 Specify Location of FTP.CFG 

 Kill EAS Service on Startup 

 Changing the Number of Concurrent Threads Used by Event Rules 

 Enable Alternative Permission Logic  

 Web Transfer Client Registry Overrides  

 EFT Server Transfer Engine Stub  

 Reverse Banned File Logic 

 HTTP->HTTPS Redirection 

 Upload Throttling 
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 ODBC Auth Manager 

 Maintain Password History for "Change Password" Validation 

 Legacy SMTP Send Behavior 

 HTTP Engine Use Server Time Zone  

 Folder Monitor Change Filter Override  

 Redirect Custom Command Output to Connected FTP Clients  

 Disable COMB Command  

 ClientFTP.DLL Enable Logging Override  

 Ignore Active Directory Home Directories 

 Enable Oracle 

 Buffered CFG Writes 

To backup the registry 

1. Click Start > Run. The Run dialog box appears. 

2. In the Open box, type regedit , then press ENTER. The Registry Editor appears. 

3. Do one of the following: 

 To backup the entire registry, click My Computer. 

 To backup a specific group of keys or a specific key, click the folder or key. 

4. On the main menu, click File > Export. The Export Registry File dialog box appears. 

5. Specify a name and location for the file, then click Save. The export process begins. 

If you are exporting the entire registry, it can take a few minutes, and the file size can be up to 
100 MB or more. If you are exporting just one key, the file size is approximately 1 KB. 

6. After you edit the registry, if you are experiencing problems caused by editing the registry, you 
can import the backed up file: 

a. On the main menu, click File > Import. The Import Registry File dialog box appears. 

b. Click the .reg file to import, then click Open. The import process begins. If you are 

importing the entire registry, it can take a few minutes. 

To create a .reg file 

1. In a text editor, such as Notepad, type or paste the following text on the first line: 

Windows Registry Editor Ver sion 5.00  

2. On the second line, type or paste the key path. For example, type: 

[HKEY_LOCAL_MACHINE\ SOFTWARE\ GlobalSCAPE Inc. \ EFT Server 4.0 \ EventRules]  

(include brackets) 

3. On the third line, type or paste the name of the key and the value (DWORD) for the key. For 
example, type: 

"FolderMonitorWorkerThreadCount"=dword:00000100  

(include quotation marks) 

4. Close the file and save it with a .reg extension. For example, type: 

threadcount.reg  

5. Double-click the file and follow the prompts to install the key into the registry. If you receive an 
error, open the file to verify the information was typed correctly. The .reg file can be transported 

to and used on other computers. 
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To create the key manually 

1. Click Start > Run. The Run dialog box appears. 

2. In the Open box, type reg edit , then press ENTER. The Registry Editor appears. 

3. Expand the My Computer node, the HKEY_LOCAL_MACHINE node, and the SOFTWARE node 
to find the GlobalSCAPE nodes. 

4. Click the applicable GlobalSCAPE node (as described below), then right-click it, point to New, 
then click Key. This makes a new folder under the GlobalSCAPE node.  

5. Type a name for the key based on the instructions below, then press ENTER. 

6. Right-click the key, point to New, then click DWORD Value. 

7. Type a name for the DWORD value based on the instructions below, then press ENTER. 

8. Double-click the DWORD. The Edit DWORD Value dialog box appears. 

9. In the Value data box, type an integer (based on the instructions below), then click OK. 

10. Close the registry, then restart the Server service. 

 

Some of the keys below should be created in the EFT Server 3.0 folder, and some should be 
created in the EFT Server 4.0 folder. Do NOT change the path to match your version of 
EFT Server. 

Specify Location of FTP.CFG  

In EFT Server 4.0.8 and later, you can create a registry key to override the location of the FTP.CFG file. 
When this key is present, the FTP.CFG is loaded from the specified path instead of the default, which is 
the folder hosting the executable. This feature was added to help with multiple nodes using the same 
configuration, such as active/passive configurations.  

HKEY_LOCAL_MACHINE\ SOFTWARE\ GlobalSCAPE Inc. \ EFT Server 4.0 \ Config  

"Path= <path_to_config_file> "  

For example, If you want EFT Server to use the CFG file at G:\Configs\EFT\FTP.cfg, you would 
create the following registry value:  

HKEY_LOCAL_MACHINE\ SOFTWARE\ GlobalSCAPE Inc. \ EFT Server 

4.0 \ Config \ Path="G: \ Configs \ EFT\ "  

Include the trailing backslash. UNC paths can be used as well. The Server service must be run 
under an account that has access (NTFS) to the specified resource. (For instance, if it is logging in 
as LocalSystem and the CFG file is not saved to the shared drive.) 

Kill EAS Service on Startup  

If this registry key is present and set to "1", EFT Server will find and kill any EASServer.exe processes.  

HKEY_LOCAL_MACHINE\ Software \ GlobalSCAPE Inc. \ EFT Server 4.0 \  

"KillEASServersAtStartup"=dword:00000001  

Changing the Number of Concurrent Threads Used by Event Rules 

The Event Rule Monitor Folder process is limited to 3 concurrent threads by default. This means that if 
you have 5 Folder Monitor Event Rules monitoring the same folder, and a file is added to the monitored 
folder, only 3 of the 5 Rules will fire, as determined by the operating system. The 4th and then 5th Rule 
execute only when one or more of the first three threads are done firing and executing any actions. If you 
have, for example, 100 concurrent Monitor Folder Event Rules, they are not all triggered simultaneously.  
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To override the default, create the following key: 

"HKEY_LOCAL_MACHINE\ SOFTWARE\ GlobalSCAPE Inc. \ EFT Server 

4.0 \ EventRules \ FolderMonitorWorkerThreadCount"  

(DWORD: the number of allowed concurrent threads) 

Enable Alternative Permission Logic  

This registry key determines whether EFT Server checks for the "Delete" permission when a client 
uploads a file.  

 If this setting is not present and/or set to zero, when a connecting client uploads a file, EFT 
Server checks only for Upload permission. If a file already exists with the same name, it will be 
overwritten. 

 If this registry setting is present and non-zero, then EFT Server determines if an upload will delete 
(overwrite) an existing file. If a file already exists, EFT Server does an additional check for Delete 
permission. 

"HKEY_LOCAL_MACHINE\ SOFTWARE\ GlobalSCAPE Inc. \ EFT Server  4.0 \ Config \ UplReqDel"  

(DWORD: if non - zero value, EFT Server checks if client has Delete permission.)  

Web Transfer Client Registry Overrides  

You can override the hard-coded location of the Web Transfer Client files by settings some registry 
values to indicate the new location of the files you would like to use. The registry key indicates the 
specific file used by the Web Transfer Client, and the value of the key indicates the full file path to use for 
the file.  

 

To use this key, set use_registry  dword to 1 (same path). 

[HKEY_LOCAL_MACHINE\ SOFTWARE\ GlobalSCAPE Inc. \ EFT Server 4.0 \ EFTClient \ ]  

http - applet:/eftclient/eftwebclient.htm  

http - applet:/eftclient/EFTAppletFunctions.js  

http - applet:/eftclient/eftwebclientlogic.js  

http - applet:/eftclient/EFTStyles.css  

http - applet:/eftclient/eft.jar  

http - applet:/eftclient/chttpclient.jar  

http - applet:/eftclient/httpimpl.jar  

http - applet:/eftclient/jclientupload.jar  

http - applet:/eftclient/clogging.jar  

http - applet:/eftclient/weakssl.jar  

You can add each of the keys you need to a .reg file in the following format: 

Windows Registry Editor Version 5.00  

[HKEY_LOCAL_MACHINE\ SOFTWARE\ GlobalSCAPE Inc. \ EFT Server 4.0 \ EFTClient]  

"use_registry"=dword:00000001  

"http - applet:/EFTClient/EFTWebClient.htm"="C: \ \ Program 

Files \ \ GlobalSCAPE \ \ EFT\ \ EFTClient \ \ EFTWebClient.htm"  
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Less commonly used Web Transfer Client Registry Overrides:  

http - applet:/eftclient  

http - applet:/favicon.ico  

http - applet:/eftclient/META -

INF/services/org.apache.commons.logging.LogFactory  

http - applet:/org/apache/log4j/Logge r.class  

http - applet:/javazoom/transfer/client/util/resources.class  

http - applet:/javazoom/transfer/client/util/resources_en.class  

http - applet:/javazoom/transfer/client/util/resources_en_US.class  

http - applet:/javazoom/transfer/client/util/resources_en_US.pro perties  

http - applet:/eftclient/commons - logging.properties  

http - applet:/javazoom/transfer/client/util  

http - applet:/org/apache  

Other Registry Overrides:  

http - applet:/ManageAccount  

EFT Server Transfer Engine Stub  

 Windows Registry Editor Version 5.00  

[HKEY_LOCAL_MACHINE\ Software \ GlobalSCAPE Inc. \ TED 6 \ Settings \ Connection]  

[HKEY_LOCAL_MACHINE\ Software \ GlobalSCAPE Inc. \ TED 6 \ Settings \ Transfer]  

"PASVMode"=dword:00000001  

Setting 2 is PASV mode; setting 0 is PORT mode 

Reverse Banned File Logic 

On the Advanced tab for a Site, you can block the upload or download of certain file types. The key 
below reverses that "banned file logic" from the current "By default allow all files except those below:" to 
"By default exclude all files except those below:ò That is, a REVERSAL of the current logic, The reversed 
logic filters out ALL by default, and only allows in those that the administrator specifies. (For example, if 
you want to allow only .txt files.) 

To activate this feature, create the following key: 

"HKEY_LOCAL_MACHINE\ Software \ GlobalSCAPE Inc. \ EFT Server 

3.0 \ RestrictionByFileNameOnUpload"  

(DWORD; non-zero means reverse the logic for banned files [exclude all except those listed]) 

HTTP->HTTPS Redirection 

In EFT Server 5.1 and later, if you have installed the HS-PCI module, you can redirect HTTP connections 
to HTTPS on the Connection Options tab of the Site. The HTTP engine listens to a specified port 
(default 80) even when OFF; all traffic is redirected to the HTTPS port on the same host (using HTTP 
header), by responding with a redirect. 

To activate this feature prior to version 5.1 or if your HS-PCI module has expired, create the 
following key: 

"HKEY_LOCAL_MACHINE\ Software \ GlobalSCAPE Inc. \ EFT Server 3.0 \ Redi rectHTTPtoHTTPS"  

(DWORD; non-zero means all traffic coming to HTTP port will be redirected to HTTPS port using HTTP 
protocol (header redirection).  

 

The HTTP port will be LISTENING even if the check box is OFF for that protocol, including 
through DMZ Gateway. 
The connecting client might receive the 302 status/error code, which means the connection 
was moved. 
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Upload Throttling 

The keys below can be used to prevent a connected client from uploading more than <n> files in <t> 
seconds. 

To activate this feature, create the following keys: 

"HKEY_LOCAL_MACHINE\ Software \ GlobalSCAPE Inc. \ EFT Server 

4.0 \ Config \ UploadsPerClient"  

(DWORD; this is the count of uploads allowed in the period) 

"HKEY_LOCAL_MACHINE\ Software \ Glo balSCAPE Inc. \ EFT Server 

4.0 \ Config \ UploadsPerClientInterval"  

(DWORD; this is the interval period, in seconds)  

ODBC Auth Manager 

This key only applies to external ODBC user authentication databases to allow for the "Settings Level" 
column in the database to specify into which settings level a user is placed for new user creation and any 
synchronization to move a User Setting Level (and home folder) when changed in the database. Refer to 
Creating Tables for you ODBC Data Source for details of the database tables. A SQL script is provided 
that will create the necessary tables. 

To activate this feature, create the following key: 

"HKEY_LOCAL_MACHINE\ Software \ GlobalSCAPE Inc. \ EFT Server 

3.0 \ EnableODBCSettingsLevelField"  

(DWORD; non-zero to enable the feature) 

Maintain Password History for "Change Password" Validation 

In EFT Server 5.1 and later, you can set the password history in EFT Administrator. Remembering the 
last <n> passwords is also configurable in the registry. This registry setting is available only with 
"GlobalSCAPE Authentication" and the password type must be "Standard" (Regular).  

To activate this feature in versions prior to 5.1, create the following key: 

"HKEY_LOCAL_MACHINE\ Software \ GlobalSCAPE Inc. \ EFT Server 3.0 \ PasswordHistoryLimit"  

(DWORD; 0 means no history) 

Legacy SMTP Send Behavior 

This key is used for communicating with legacy SMTP servers that do not support RFC 1652 or if having 
trouble sending messages through your existing SMTP server.  

"HKEY_LOCAL_MACHINE\ Software \ GlobalSCAPE Inc. \ EFT Server 

4.0 \ LegacySMTPSendBehavior"  

(DWORD; non-zero to enable the feature) 

http://www.ietf.org/rfc/rfc1652.txt
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HTTP Engine Use Server Time Zone  

In EFT Server version 5 and later, you can create/edit this registry key to alter the behavior of the HTTP/S 
engine's directory listing format. By default, files and folders are displayed using UTC; however, if this 
registry value is present and non-zero, we use the Server's time zone for file/folder listings in the HTTP/S 
engine. 

0 - use UTC file times 

!0 - use Server time zone for file times 

 HKEY_LOCAL_MACHINE\ Software \ GlobalSCAPE Inc. \ EFT Server 4.0 \  

 "UseServerTimeZone"=dword:00000001  

Folder Monitor Change Filter Override  

In EFT Server version 5.1.1 and later, you can create/edit a registry key to set the "dwFilter" parameter 
that is passed into the function "ReadDirectoryChangesW()", which is the core of the Folder Monitor 
feature.  

 HKEY_LOCAL_MACHINE\ Software \ GlobalSCAPE Inc. \ EFT Server 4.0 \ EventRules  

 "FolderMonitorFilterValue"=dword:0000007D  

The default value is:  

FILE_NOTIFY_CHANGE_FILE_NAME | FILE_NOTIFY_CHANGE_ATTRIBUTES | 
FILE_NOTIFY_CHANGE_SIZE | FILE_NOTIFY_CHANGE_CREATION | 
FILE_NOTIFY_CHANGE_LAST_WRITE | FILE_NOTIFY_CHANGE_LAST_ACCESS 

(This is a value of 0x7D) 

This override is used to "quiet" folder monitor event dispatching; for example, if only looking for NEW files 
added to the folder, then exclude the "FILE_NOTIFY_CHANGE_FILE_NAME | 
FILE_NOTIFY_CHANGE_ATTRIBUTES | FILE_NOTIFY_CHANGE_LAST_ACCESS" set.  

Redirect Custom Command Output to Connected FTP Clients  

In EFT Server version 5.1.1 and later, you can create/edit a registry location to cause the output of an 
Event Rule-executed custom command (when "redirect output to client" is on) to be sent back over the 
FTP command channel. This option is disabled by default (which is legacy behavior), but setting this 
DWORD registry value to a non-zero integer will result in this behavior. The Event Rule must be executed 
SYNCHRONOUSLY for the output to be redirected to the client, so you should ensure at least one IF 
FAILED Action is defined to force synchronous operation.  

 HKEY_LOCAL_MACHINE\ Software \ GlobalSCAPE Inc. \ EFT Server 3.0 \  

 "FileUploadEventResult"=dword:00000001  

Disable COMB Command  

In EFT Server 5.1.1 and later, to avoid problems with multipart uploads causing multiple file upload 
events, you can create/edit a registry location to disable the COMB command on the Server. Restricting 
transfers to one-part uploads will result in slower transfers, but will greatly reduce headaches when you 
want to process uploaded files, because a file upload success is the entire file. This option is disabled by 
default (legacy behavior), but setting this DWORD registry value to a non-zero integer causes COMB to 
be disallowed and not shown in the response to FEAT.  

 HKEY_LOCAL_MACHINE\ Software \ GlobalSCAPE Inc. \ EFT S erver 3.0 \  

 "DisableCOMBCommand"=dword:00000001  

 

ClientFTP.DLL Enable Logging Override  

After a transfer is complete, EFT Server will remove log files. Starting with EFT5.1, you can create/edit a 
registry location to cause the ClientFTP.DLL engine to retain the client log files.  
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To activate this feature, create the following key: 

 "HKEY_LOCAL_MACHINE\ Software \ GlobalSCAPE Inc. \ TED6\ EnableLogging"  

(DWORD:00000001) 

Set the DWORD value to "1" to retain log files. The log files appear in the same LOGS folder that the "cl" 
log files appear, in the file name format of "[07.11.30_12.11]-#000004.log".  

Other values under the Settings \ LogWindows key may need to be tweaked to ensure that logs are 

enabled and not being deleted.  

Most importantly, the following values need to be set to 0 to prevent logs from being automatically 
deleted: 

 "DeleteSessionLogFiles" (one log per FTP session) 

 "DeleteItemLogFiles" (one log per FTP transfer) 

 "DeleteLogsAfterCloseTE" (deletes logs while the client is unloaded) 

 "CloseFinishedItemLogs" (deletes logs for successfully completed transfers)  

You might also want to edit the following settings: 

 Disable the "DeleteOldLogs" setting or tweak the "QuantityUnitForDeleteLogs" and 
"UnitForDeleteLogs" settings, which affect how often old logs are deleted.  

 Ensure that the "EnableXferLog", "EnableMDILog", and "EnableVFSLog" settings are set to 1 so 
that each of these log types are created - these settings have more to do with the different ways 
that CuteFTP can display logs than with the operation of the FTP client, but leaving all of them 
enabled is probably the safest setting.  

 Turn on timestamps by setting "ShowLogTimeStamps" to 1  

 Turn on raw directory listings by setting "TraceLIST" to 1. (You can actually turn on additional 
functionality of "TraceLIST" by setting it to 3 or 19 (adding a 2 bit and a 16 bit). 

The settings below illustrate possible settings to enable logging, timestamps, and raw directory listings.  

 HKEY_LOCAL_MACHINE\ SOFTWARE\ GlobalSCAPE Inc. \ TED 6 \ Settings \ LogWindow  

 "DeleteSess ionLogFiles"=dword:00000000  

 "DeleteItemLogFiles"=dword:00000000  

 "DeleteLogsAfterCloseTE"=dword:00000000  

 "CloseFinishedItemLog"=dword:00000000  

 "DeleteOldLogs"=dword:00000001  

 "QuantityUnitForDeleteLogs"=dword:00000003  

 "UnitForDeleteLogs"=dword:00000002  

 "EnableXferLog"=dword:00000001  

 "EnableMDILog"=dword:00000001  

 "EnableVFSLog"=dword:00000001  

 "ShowLogTimeStamps"=dword:00000001  

 "TraceLIST"=dword:00000001  

Ignore Active Directory Home Directories 

(This feature was added in version EFT 5.1.6 and is not backwards compatible.) This registry key is used 
to allow EFT Server to ignore Active Directory (AD) home directories; that is, you do not want EFT Server 
to create virtual directories that point to the AD home directories. 

Using this key, if you set the I gnoreADHomeDirs registry DWORD value to 1, when AD users log in to 

the Server, rather than the Server creating a virtual folder that links to the user's AD-defined folder, a 
folder is created under the Server root directory using the user's login name (assuming you have selected 
the Automatically create a home folder for newly added users check box when you created the Site). 
Refer to Creating a Site that Uses NT Authentication for details, if necessary. 
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This value only affects a new Site. Before creating the AD Site, set the registry DWORD value, 
then restart the EFT Server service. You must specify an AD Group when you create the Site. 
If the Site is already created, you can specify the Group in the Authentication Options dialog 
box. 

To activate this feature, create the following key: 

"HKEY_LOCAL_MACHINE\ Software \ GlobalSCAPE Inc. \ EFT Server 

3.0 \ IgnoreADHomeDirs"  

(DWORD; 1 to enable, 0 (default) to disable) 

More information: 

Suppose you want to create home folders that follow a specific sequence other than the user's 
login name, such as user first name underscore last name, e.g. John_Smith. You would first set 

the IgnoreADHomeDirs registry value (so that the virtual folder pointers are not created), then 

after creating a Site and pulling in your AD users, you could use EFT Server's COM API to quickly 
scan and assign each user to a home folder using the naming convention/pattern desired. Of 
course, you would want to automate the script and run it regularly to query for newly added users 
that have not yet been assigned a home folder; otherwise, when they log in, they will be assigned 
the default folder based on their login name. If the Automatically create a home folder for newly 
added users check box is not selected, and a user attempts to login before you have assigned 
them a folder (either through COM or manually), the user will not be able to list or see any 
directories (sort of in limbo). So regularly running the script (or ensuring you manually create the 
folder every time a user is added) is critical.  

Enable Oracle 

(EFT Server 5.1.7 and later) This key only applies if you are using an Oracle auditlogger.dll provided by 
GlobalSCAPE. With this key enabled, if the Server uses an Oracle database, you can upgrade to future 
releases by installing your custom auditlogger.dll in the Server installation directory. 

To activate this feature, create the following key: 

"HKEY_LOCAL_MACHINE\ SOFTWARE\ GlobalSCAPE Inc. \ EFT Server 3.0 \ DBType 

(DWORD; if the key does not exist or is 0 = MSSQL; 1 = Oracle 

Buffered CFG Writes 

(In EFT Server 5.1.7 and later) The writing of the configuration (cfg) file to EFT Server occurs 1 byte at a 
time. This key enables the Server to write the file in "chunks" instead of 1 byte at a time. If you are 
experiencing long delays when applying changes to the Server, try enabling this key to improve response 
time.  

To activate this feature, create the following key: 

"HKEY_LOCAL_MACHINE\  SOFTWARE\ GlobalSCAPE Inc. \ EFT Server 

4.0 \ UseBufferedArchiveWriter"  

(DWORD; 1 to enable, 0 or does not exist (default) disable) 

Running EFT Server and Microsoft IIS on the Same Computer 

By default, the FTP server in Microsoft IIS binds to port 21 on all IP addresses. If you want to run both the 
IIS FTP server and EFT Server, you need to disable socket pooling for the IIS FTP server.  
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To disable socket pooling in IIS FTP server  

 In Microsoft IIS, stop the FTP site as described below:  

1. Open a command prompt.  

2. Change directory to C:\InetPub\Adminscripts:  

cd C: \ InetPub \ Adminscripts  

3. Type CSCRIPT ADSUTIL.VBS SET MSFTPSVC/DisableSocketPooling TRUE 

then press ENTER.  
 

You should get the following response: disablesocketpooling : (BOOLEAN) 

True  

4. Exit the command prompt and restart the FTP site. This should prevent IIS from binding 
to all IP addresses on port 21, freeing up an IP address on port 21 (the default FTP port).  

For more information on Microsoft IIS socket pooling, see the following articles:  

http://support.microsoft.com/default.aspx?scid=kb;en-us;259349  

http://support.microsoft.com/default.aspx?scid=kb;EN-US;238131  

The articles linked above discuss the IIS Web server, but the same information applies to the IIS FTP 
server.  

"Unexpected Error 0x8ffe2740 Occurred" Message When You Try to Start EFT Server 

Microsoft IIS uses port 80 for HTTP communication. If you are running the IIS FTP server and EFT Server 
on the same computer, you can do either of the following: 

 In IIS Manager, change the port bindings for the Web site to a port other than port 80.  

 Stop the application that is using port 80, and then start the Web site from IIS Manager.  

For more information, refer to the Microsoft Knowledge Base article #816944. 

http://support.microsoft.com/kb/816944/en-us  

EFT Server in the Windows Event Viewer 

Certain EFT Server events, such as service startup and failure, appear in the Windows Event Viewer 
Application Log. 

http://support.microsoft.com/default.aspx?scid=kb;en-us;259349
http://support.microsoft.com/default.aspx?scid=kb;EN-US;238131
http://support.microsoft.com/kb/816944/en-us
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 Click the Source column header to group the GlobalSCAPE EFT Server logs together. 

 The Category column displays the component, if applicable, that caused the log to be written. In 
the example above, ARM appears in the Category column. (ARM did not start because it was 

unable to connect to the database.)  

Release Notes 

Release notes for EFT Server are available in the installation directory (by default, C:\Program 
Files\GlobalSCAPE\EFT\notes.txt). 

EFT Server version history is available online at http://www.globalscape.com/eft/history.aspx. 

 

http://www.globalscape.com/eft/history.aspx
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Configuring EFT Server 

Your First Connection to EFT Server 

After you follow the procedures in Installing and Activating the Software, the next step is to log in to EFT 
Server via EFT Administrator and configure the client connections to EFT Server. 

When you connect to EFT Server for the first time, you must configure it on the computer on which the 
GlobalSCAPE EFT Server service is installed. After you have created the local connection and enabled 
remote connections, you can connect to and administer EFT Server remotely. 

To connect to EFT Sever for the first time 

1. Launch EFT Server by clicking the shortcut on the Start menu or desktop  (cftpsai.exe). The 
EFT Server interface, EFT Administrator, opens and the New Administrator Connection wizard 
appears.  
 

 

2. Since you are configuring the local connection, leave This computer selected, and specify the 

label for the local connection. By default, the label is LocalHost . Since LocalHost is a very 

common label, it is a good idea to change the label to something that is easily identifiable in error 

logs, reports, and remote connections. For example, you could type: SA EFT Server.  

3. The Host address box is used for remote connections and is not editable for local connections. 

4. In the Port box, keep the default of 1100 or, for increased security, change this vendor default to 
another port that is not being used by another connection on the network. Remember this port 
number if you plan to configure a remote connection to this server. 
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5. Click Next. The login page appears. 
 

 

6. In the Username and Password boxes, provide the administrator credentials that you 
created when you installed EFT Server, then click Connect. The Welcome page of the EFT 

Server Setup wizard appears. 
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7. Click Next and follow the instructions in the wizard and in Server Setup Wizard to create your first 
EFT Server, or click Cancel to do it later.  

After you create the Server in EFT Administrator, the Site Setup wizard appears for you to create your 
first Site, then the User Setup wizard appears to help you create users. (You can cancel the wizard after 
your Server or Site is created, if you do not have time to do it all in one sitting or if you want to read the 
help files before continuing.) 

EFT Server Interface 

EFT Administrator is the graphical user interface to EFT Server. After you install one or more EFT 
Servers, configure clustering services, if used, and configure EFT Server to run as a Windows service, 
you then configure the connection to EFT Server in EFT Administrator. EFT Server is configured by 
default to run when the operating system boots up. EFT Administrator is used to connect to EFT Server 
and create Server Groups, Servers, and Sites, manage user accounts and permissions, set security 
protocols and commands, configure Event Rules, and run reports.  

EFT Administrator connects to EFT Server on either a local or remote computer. You can install EFT 
Administrator on as many computers as you like, but EFT Server may only be installed on computers with 
valid EFT Server software licenses. 


